# Contents

## Image Acquisition

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting the System</td>
<td>4</td>
</tr>
<tr>
<td>Visual observation with microscope</td>
<td>5</td>
</tr>
<tr>
<td>XY Image Acquisition</td>
<td>6</td>
</tr>
<tr>
<td>XYZ Image Acquisition</td>
<td>8</td>
</tr>
<tr>
<td>XYT Image Acquisition</td>
<td>9</td>
</tr>
<tr>
<td>4D (XYZT) Image Acquisition</td>
<td>10</td>
</tr>
<tr>
<td>XYT Image Acquisition (with Z drift compensation)</td>
<td>11</td>
</tr>
<tr>
<td>Multi Area Time Lapse</td>
<td>12</td>
</tr>
<tr>
<td>Multi Area Time Lapse using Map Image (1)</td>
<td>14</td>
</tr>
<tr>
<td>Tips of Image Acquisition</td>
<td>17</td>
</tr>
<tr>
<td>Exiting the system</td>
<td>18</td>
</tr>
<tr>
<td>Configuration</td>
<td>19</td>
</tr>
</tbody>
</table>

## Processing Image

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D view and operation</td>
<td>21</td>
</tr>
<tr>
<td>3D view and operation</td>
<td>22</td>
</tr>
<tr>
<td>Creating the movies</td>
<td>23</td>
</tr>
<tr>
<td>Processing: Projection</td>
<td>24</td>
</tr>
<tr>
<td>Exporting the image</td>
<td>25</td>
</tr>
<tr>
<td>Reloading and saving Observation Methods</td>
<td>26</td>
</tr>
</tbody>
</table>

## Spectral Imaging

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lambda Series (acquiring by single channels)</td>
<td>28</td>
</tr>
<tr>
<td>Lambda Series (acquiring by multiple channels)</td>
<td>30</td>
</tr>
<tr>
<td>Processing: Unmixing (1)</td>
<td>32</td>
</tr>
<tr>
<td>Processing: Unmixing (2)</td>
<td>33</td>
</tr>
<tr>
<td>Processing: Unmixing (3)</td>
<td>34</td>
</tr>
</tbody>
</table>
Starting the system

Starting the system

Turning ON the power
① Set the main switch of the PC to ON
② Switch on the central power.

Laser controller
③ Switch on the main power of each laser. And Rotate the start key.

Touch Panel Controller (TPC)
④ Press the main switch of the touch panel controller to set it to ON.

Mercury burner for the light source
⑤ Press the lamp switch on the front side of the light source.

Logon Windows
⑥ Logon Windows with your own user ID and password.

Factory Default ID & password
Factory User ID: olympus
Password: olympus

Starting software for FV3000
⑦ Double-click the [FV31S-SW] icon on the desktop.
※Start the software after “Start operation” is displayed in TPC.
⑦ The stage setting dialog box appears. Set each checkbox and click [OK].
**Visual observation with microscope**

**Transmitted DIC observation**
*Tap the button on the TPC to select the objective for observation.

1. Tap the light path selection button of the touch panel controller.
2. Tap the [DIA] button.
3. Tap the [DIA] tab.
4. Tap the [Elements] tab and check whether the [Polarizer] is “IN”.
5. Insert the DIC prism slider.

Adjust the DIC contrast by rotating the knob.

6. Open the shutter of the transmission illumination light on the touch panel controller.
7. If necessary, tap the [Brightness] tab and adjust the brightness.
8. Adjust the focus and contrast.

**Fluorescence observation**
*Tap the button of the TPC to select the objective for observation.

1. Tap the light path selection button of the touch panel controller. (or select “Ocular” in [Ocular] Tool Window.)
2. Tap the [EPI] button.
3. Tap the [EPI(or EPI1) tab.
4. Select the mirror unit suitable for the fluorescent probe for observation.

5. Open the shutter of the reflected illumination light on the touch panel controller.
6. Select the ND filters to adjust the brightness.

※Brightness can be adjusted by rotating the light volume adjustment dial of the light source.

7. Adjust the focus using the focus knob.
XY Image Acquisition(1)

① Select “VBF” in the [PMT Setting] Tool Window.

Assigning the detector to channel
② Press the [Dye & Detector Select] button on [PMT Setting] Tool Window to open the [Dye & Detector Select] dialog box.
③ Press the [All Clear] button to reset the Assigned Dye.
④ Double-click the name of the fluorescence dye to observe.

Virtual Channel Scan
This mode allows to acquire multiple CH image whose channel number is larger than the number of detector.

⑤ When registering a fluorescence dye, TD channel is registered automatically. If you don’t need, double-click the TD channel to cancel it.
⑥ If you want to observe with multiple phases using the virtual channel scan, press the [Add Phase] button to add the phase. And drag&drop the selected “Dye” to the observation channel list of the phase you want to add.

⑦ After setting all channels, press the [OK] button.

Adjusting the live image
⑧ If you want to acquire multiple channel image, select Sequential scan “Line” in the [PMT Setting] Tool Window.
⑩ If you use virtual channel scan, press [Phase1] [Phase2] to switch phases. On both phases, adjust focus and set Laser Intensity(%), Sensitivity(HV), Gain and Offset.

[H]Lo Mode
pixels of intensity 4095 are shown in red.
Pixels of intensity 0 are shown in red.
確認（英語のほう）
元島 ゆき, 03.02.2017
**XY Image Acquisition (2)**

### Setting the scanner


11. Set scanning speed.

12. Specify “Image Size” to set the scan area.

13. Set the zoom, rotation and clip scan if needed.

### DIC observation

1. Insert the DIC slider to microscope.
2. Register the TD channel.
3. Set the laser to be used for observation.
4. Adjust the sensitivity (HV).
5. Adjust the contrast by rotating the knob of the DIC slider.
   (See page 3 ⑤ in left side.)

### Starting Acquisition

14. Select [Normal] tab in [Acquire] Tool Window. Press the button to open the dialog box, and select the folder to save the images.

   *The acquired images are saved automatically. Serial number is added at the end of file name like “***_0001” and “***_0002”.

15. Press button to start acquiring the image.

**Attention**

Check [LSM] in [Series] Tool Window whether it is selected “OFF” [Z] and [Time].
Before starting the following procedure, make adjustments for XY imaging.
(refer to page 4-5.)

Setting Z series

Register start/end position
3. Change the Z position by rotating the focusing knob or pressing the button. Press the button in [Start] at the Z position to start acquiring the image.
4. Change the Z position and go on to press the button in [End] at the Z position to end acquiring the image.
5. Enter a value in [Slices] or [Step Size]. Setting one will set other automatically. Pressing the button, both numerical values “Slices” and “Step Size” is optimized.

Starting Acquisition
6. Select [Normal] tab in [Acquire] Tool Window. Press the button to display the dialog box, and select the folder to save the images.
Press the button to start acquiring the image.

Finishing Acquisition
Press the button to complete the image acquisition. If you want to Additional images under the same condition, enter the number of additional acquisition and press the button. After the image is acquired, press the button.
u6  新しく追加。要チェック。
元島 ゆき; 08.02.2017

u7  Step Sizeにしたけど大丈夫だろうか？
内容・英語ともに。
元島 ゆき; 08.02.2017
XYT Image Acquisition

*Before starting the following procedure, make adjustments for XY imaging. (refer to page 4-5.)*

**Setting Time Series**
2. Set the interval to acquire the image in [Interval] and [Cycle] on [Time Lapse].

   *If you attempt to set the shorter than the time displayed in [Scan] in [Interval], “FreeRun” appears. In this case, the interval to acquire the image is the time displayed in [scan].*

**Starting Acquisition**
3. Select [Normal] tab in [Acquire] Tool Window. Press the button to display the dialog box, and select the folder to save the images.

   *The acquire images are saved automatically. Serial number is added at the end of file name like “***_0001” and “***_0002”.*

4. Press the button to start acquiring the image.

**Finishing Acquisition**
7. Finishing acquisition, buttons blink.

   Press the button to complete the image acquisition. If you want to Additional images under the same condition, enter the number of additional acquisition and press the button. After the image is acquired, press the button.
4D Image Acquisition

*Before starting the following procedure, make adjustments for XY imaging. (refer to page 4-5.)

① Select “ON” in both [Z] and [Time] on [Series] Tool Window.

**Setting Z series**
② Changing the Z position, register the Z position of Start/End.
③ Set either [Slices] or [Step Size]. (See p.6 for details.)

**Setting Time series**
④ Set the interval to acquire the image in [Interval] and [Cycle] on [Time Lapse].

**Starting Acquisition**
⑤ Select [Normal] tab in [Acquire] Tool Window. Press the button to display the dialog box, and select the folder to save the images.
*The acquire images are saved automatically. Serial number is added at the end of file name like “***_0001” and “***_0002”.
⑥ Press the button to start acquiring the image.

**Finishing Acquisition**
⑦ Finishing acquisition, buttons blink.
Press the button to complete the image acquisition. If you want to Additional images under the same condition, enter the number of additional acquisition and press the button. After the image is acquired, press the button.
**XYT Image Acquisition**
(with the Z drift compensation)

* In advance, prepare to use ZDC. (See page 22 for details.)
* Set for acquiring the series image.

### Setting Near limit

2. Press the **Register current position as near limit** button to set the Near limit to all objective lenses in [Z limit Setting].
3. Pressing the **Register** button to current position as 0 position.

### ZDC Setting

2. Specify the search zone of the coverslip position in [Upper Limit] / [Lower Limit] in [Search Zone].
4. Adjust focus and press the **Find** button of [Coverslip position]. The coverslip top surface position is acquired. When the Z drift compensation is successful, the buzzer sounds beeps once only. If the Z drift compensation is not successful, the buzzer sound beeps three times.
5. When performing the Z drift compensation continuously during series scan, press the **Continuous AF** button in [ZDC Control] in [Microscope] Tool Window. As this function performs the drift compensation in real-time during series scan, the focusing can be at a high-speed.

### Attention

- High-speed scanning → Use continuous AF
- If Rest time is longer then 30 seconds → You had better not use Continuous AF

6. Don’t operate ⑦.


---

If [Rest] is shorter than 31 seconds, Z drift correction works only first scanning. For every time working, set the [Interval] so that the [Rest] to be 31sec or longer.
Multi Area Time Lapse Imaging Acquisition

*Before starting the following procedure, make adjustments for XY imaging.

① Press the \( \bigtriangledown \) button in [Live] Window.
② Select the [Map] sub pane.

Registering the group of MATL

③ Move the specimen to a desired position and adjust the live image. If you want to acquiring the XYZ image, make adjustments for Z series additionally.
④ Press the \( \bigtriangledown \) button to register the position and its image acquisition condition.

【Attention】
All acquiring conditions (XY position, focus position, laser intensity, sensitivity, series setting, and on.) are registered when you press the \( \bigtriangledown \) button. So, Register after you finish adjusting all conditions.

⑤ Repeat the operation of ③ and ④ to register for multi area timelapse.
⑥ Set the interval to acquire the image in [Interval] and [Cycle] on [Repeat Setting].

⑧ Press the \( \bigtriangledown \) button to display the dialog box, and select the folder to save the images.
⑨ Press \( \bigtriangledown \) button to start acquiring the image.
Multi Area Time Lapse  
(with the Z drift compensation)

*Before starting the following procedure, make adjustments for XY imaging.

**ZDC Setting (See page 10 for details.)**

1. In [▼ Limit Setting], press the button to set the Near limit to all objective lenses.

2. In [▼ Z Section] in [Series] Tool Window, press the button to set current position 0.


6. Adjust focus and Press the button of [Coverslip position]. The coverslip top surface position is acquired.

   - When the Z drift compensation is successful, the buzzer sounds beeps once only. If the Z drift compensation is not successful, the buzzer sound beeps three times.

7. Press the button to register areas.

8. set [Cycle interval] and [Cycle].

**Starting Multi Area Time Lapse**


10. Press the button to display the dialog box, and select the folder to save the images.

11. Press the button to start acquiring the image.
Multi Area Time lapse using Map Image (1)

*Before starting the following procedure, make adjustments for XY imaging.*

① Press the button in [Live Window], the sub pane appears.
② Select [Map] tab.

### Create the map

③ Bring the image into focus and adjust acquiring parameters using the low magnification objective lens.
④ Press the button to register the position and acquiring parameters.

### Attention

All parameters register by pressing the button. When acquiring a map image, Check [LSM] in [Series] Tool Window whether it is selected “OFF” [Z] and [Time].

⑤ Scroll to the right in registered area List and Ticking [OverlayMap].

### Map image acquisition

⑦ Press the button to display the dialog box, and select the folder to save the images.
⑧ Press button to start acquiring the image.
Finishing the acquisition, map image is displayed in [Map] tab.
Multi Area Time lapse using Map Image (2)

Registering the multiple area

⑨ Set the higher magnification objective lens. double-clicking on the map image, the stage is moved to at the center of the map.
⑩ Press the button to register the position and acquiring parameters.
⑪ Repeat ⑨⑩, register the multi areas that you want to acquire images.
⑫ Check the registered area List whether it is ticked to “Enable” at the area which you want acquire images.

[Attention]
All acquiring conditions(XY position, focus position, laser intensity, sensitivity, series setting, and on.) are registered when you press the button. So, Register after you finish adjusting all conditions.

⑬ If necessary, set [Cycle interval] and [Cycle].

If you want to see the image on map in real-time, tick the “OverlayMap”.

⑮ Press the button to display the dialog box, and select the folder to save images.
⑯ Press button to start acquiring the image.
Finishing the acquisition, map image is displayed in [Map] tab.
Acquiring the stitched image using Map Image

① Refer to page 12, acquiring the map image.

Define the area of acquisition
② Move the specimen to desired position using the map image as reference. Double-clicking on the map, the motorized stage moves to the position where double-clicked.

③ Press the or or button to register the area.

④ Select [MATL] tab in [Acquire] Tool Window. Press button to start acquiring the image.

⑤ Select the image tab acquired and press the button.

⑥ After the image is displayed in the dialog box, press the button.

Processing to stitch
⑤ Select the image tab acquired and press the button.
⑥ After the image is displayed in the dialog box, press the button.

*If you ticked the [Stitching] in [ ▼ Registered Area List] before acquiring the image, process to stitch automatically.

3 types
①: Registering an arbitrary matrix area
②: Registering a rectangular ROI in the map image display area.
③: Registering a polygonal ROI in the map image display area.

【Attention】
All acquiring conditions (XY position, focus position, laser intensity, sensitivity, series setting, and on.) are registered when you press the button. So, Register after you finish adjusting all conditions.

**Image Descriptions:**
- Step 1: Refer to page 12, acquiring the map image.
- Step 2: Define the area of acquisition.
- Step 3: Move the specimen to desired position using the map image as reference.
- Step 4: Press the button to register the area.
- Step 6: Press button to start acquiring the image.
- Processing to stitch.
- Select the image tab acquired and press the button.
- After the image is displayed in the dialog box, press the button.
- *If you ticked the [Stitching] in [ ▼ Registered Area List] before acquiring the image, process to stitch automatically.
Tips for Image Acquisition

For the High speed scanning
*Check whether [Scan Speed] is set “2.0μs/pixel”.

1) Changing the scanner
   * Use the Resonant scanner
   * Use the Roundtrip Mode

   When using High speed scanner, the signal gets weaker and the noise increases. So, refer to [ ■For brighter imaging ■ ] and [ ■For the lower noises ■ ] and combine them.

2) Selecting the smaller image size
3) Reducing the scanning area
   * Use “Clip scan” to limit the acquiring area.

   Scanning time is displayed in this line.
   Pixel/Line/Frame

   ★High voltage correction: This mode is the function that the sensitivity is adjusted automatically to keep brightness when scan speed is changed.

To make image more brighter
4) Increasing laser intensity / Increasing sensitivity (HV)
   ※If sufficient brightness cannot be obtained even when the sensitivity (HV) increased to 600V or higher, combine another method in additional to this method.

5) Increasing the C.A.
   ※When increasing the C.A., the Z-axis resolution gets worse.

6) Slowing down the scan speed
   ※Select “OFF” in [High voltage correction].

To lower the noise level
7) Using Average
   This method averages specified number of images during image acquisition.
   Select the “Line” or “Frame” and enter the number of image to be averaged.

8) Slowing down the scan speed
   ※Select “ON” in [High voltage correction].
Exiting the system

Exiting the software and PC
① Select [Exit] in the [File] menu to exit the software.
② Select the “Shut down” in Windows Start Menu.

Turning OFF the power
Touch Panel Controller (TPC)
③ Tap the “OFF” on display of TPC. Then press the TPC main switch. *Do not long-press the main switch.

Laser controller
⑤ Turn the laser combiner to OFF. ※Rotate start key of the Power Supply and set the switch to OFF.

Mercury burner for the light source
⑥ Long-press (2 seconds) the lamp switch on the front side of the light source to turn OFF the Mercury burner.

Central power
⑦ Switch off the central power.

*When using the immersion oil, clean the objective lens.
Configuration

Changing the objective lenses
*Exchange the objective lens to be used.
① Select [Configuration] in [Tools] menu.
The [Configuration] dialog box appears.
② Select [Microscope] tab.
③ Select [Objective Lens].
④ Select the name of the mounted objective lenses.
⑤ Specify the optical elements to be switched by interlocking during the switchover the objective lens.
*Select the DIC which is same number as the objective lens.
example: 30X→IX2-DIC30
100X→IX2-DIC100
⑥ Press the button.

Specifying the micro plate
① Select [Configuration] in [Tools] menu.
The [Configuration] dialog box appears.
② Select [Preference] tab.
③ Select [Plate].
④ Select the micro plate to be used.
⑤ Press the button.

For Z drift compensation
① Select [Configuration] in [Tools] menu.
The [Configuration] dialog box appears.
② Select [Microscope] tab.
③ Select [ZDC].
④ Specify the coverslip type to be used
⑤ Enter directly the thickness of the coverslip to be used.
⑥ If you use DIC, tick the checkbox⑥.
⑦ Press the button.
2D view and operation

**Drawing scale bar and ROI**
- A straight line can be drawn by pressing Shift key when left-clicking.

**Playing animations of the series images**
- These buttons are used to play animation of the series images.

**LUT (adjusting a color LUT)**
- Press the button to display sub pane.

**Intensity Histogram and a color LUT bar**
- The minimum and maximum intensity values displayed in the image can be set by dragging ▲ or specifying them by directly entering numeric values.
  - Bring Max smaller → Show the signal brighter
  - Bring Min bigger → Cut the dim signal (background)
- button assigns the minimum and maximum intensity values in the Raw data.
3D view and operation

Opening the file and displaying 3D image
Open and activate the Z series image.
Select [Volume] tab to display 3D image.

3D image setting
Press the button and select [Volume Setting] in [View] window menu. [Volume Setting] Tool Window is displayed.

Selecting the algorithm

- **Two algorithm**
  1. **MIP**
     The MIP method reflects the maximum intensity of the object preferentially on the image. Therefore, the area with the high intensity even in the object can be extracted.
  2. **AlphaBlend**
     The AlphaBlend method reflects the intensity on the top surface of the object preferentially to the image. Therefore, the context of the object is displayed properly.

- **Cut**
  Displays the yellow frame in the image constructed in 3D. Dragging this frame with the mouse will display only the image in the frame.

- **Slice**
  Creates the cross-sectional view sliced in XY/XZ/YZ directions in the image constructed in 3D, and displays the image sliced in each direction. The cross sections can be moved by dragging the mouse.
Creating the movie

*Opening the file and displaying 3D image

1. Press the button and select [Volume Setting] in the [Tool Window] menu.


3. Select “▼Key Frame” in [Movie Item] and press the button.
   “Sequence1” is shown below “▼Key Frame”.

4. Select “Sequence1” in [Movie Item].

Registering the Key Frame

5. Move the 3D image in [Image] window by dragging and right-click at the desired status. Right click and select [Add Key Frame], then the current display status is registered and “Key Frame x” is displayed in [Id] in [Volume Setting] Tool Window.

6. Repeat ⑤ and register the statuses you want to register them, as Key Frames.

7. When you press the button, the volume images between Key Frames are interpolated automatically to play through the movie.

Exporting movie

8. Select “Sequence xx” in [Movie Item] and select the movie you want to export. Press the button. The [Export] dialog box appears.

9. Press the button to select the folder of the save destination. Set the [File name] and [Frame rate] by entering them directly.

10. Press the button.
Processing: Projection

1. Press the button to switch to “Viewer mode”.
3. Select “Single process” and “post processing” as the illustration below.

![Selection of Processing Options]

4. Select the [Processing] tab and register “projection” in [Processing Item].
5. Double-click the [Input], Select the images for image processing.
7. Press the button.
8. The processing finishes, new image file appears.
Exporting the image

*The image can be exported in the file format which can be used by other software.

A. Exporting a single image
① Right-click on the image to be exported. Select [Export] in the menu displayed. The [Export] dialog box appears.

② The destination folder for the image to be exported is displayed in ②. If necessary, press the button to display the dialog box and change the destination folder.

③ Set the file name and select the file type in [Save as type].

④ Select the channel to be exported in [CH/Range]. When exporting the series images, set the range to be exported and the number of the steps in ④.

⑤ When general purpose format is selected in [Save as type] in ③, set whether or not to overlay the ROI on the image to be exported.

⑥ When general purpose format is selected in [Save as type] in ③, select the method to export channels and the bit color.

⑦ Ticking this checkbox will output the properties (acquisition conditions when acquiring the image) in text.

⑧ Press the button. The image will be exported.

B. Exporting multiple images
⑨ In the [File] menu on the software screen, select [Export multiple files]. The [Export multiple files] dialog box appears.

⑩ Select the method to export images. Press the button to select the folder or the file to be exported.

⑪ Select the save destination and file format to be exported in [Save as Type].

⑫ 4~7

⑬ Press the button. The image will be exported.
Loading and saving Observation Methods

Save / load the observation method
① Select the [Observation Method] in [Tool Window] menu.
* Each functions
- -: to load the acquisition parameters and set to FV
- -: to save the current conditions and add to the list
- -: to update the current conditions
- -: to delete the condition from the list
- -: to sort the list
- -: to export/import the methods

Check the acquiring condition
① Press the button and open sub pane.
② Select the [Property] tab and check the acquiring conditions.

Load acquisition parameters from acquired image
In [Property] in sub pane, press the button.
Spectral Imaging
Lambda series
(acquiring by a single channels)

*Before starting the following procedure, make adjustments for imaging. (refer to page 4-8.)

Changing to Lambda mode

Select one channel to be used
② Press the button. The [Dye & Detector Select] dialog box appears. Press the button to reset the Assigned Detector.

③ Select the [Channel] tab in [Dye & Detector Select] dialog box. Select the “High Sensitive Detector CH1” in [Detector List], and press button. Press the OK button to close the [Dye & Detector Select] dialog box.

④ Tick the checkbox of the wavelength of the excitation laser to be used.

Setting DM and SDM

⑥ Select [LSMScanner] tab in [Lightpath] Tool Window. Press the DM button to display the dichroic mirror list. Select “DM” which reflects the wavelength of the excitation laser selected in ④.

⑦ Check the light path whether the light path is set properly. See the figure(A).

Setting “Band width” and “Step Size”
⑧ In [PMT Setting] Tool Window, set the width of the wavelength for which the spectral image acquisition is performed per each step in [Band width], and set the interval between the wavelength to start acquisition in the next step in [Step size].

Standard
・Bandwidth : 15μm is recommended. If the live image is dark, widen the Bandwidth.
・Step Size : 5nm is recommended. The narrower the Step Size, the more accurate the analysis.
**Lambda series**

(acquiring by a single channels)

---

**Setting the wavelength**

⑨ Set them by dragging the mouse on the profile display area or set the value of wavelength directly to [CH1]. (★)

**Adjusting the live image**

⑩ Press the button to start scanning.

⑪ In ⑪ in left figure, enter the value of wavelength directly, to find the most efficient (brightest) range. Entering the value in the left box, changes the value in the right box based on Bandwidth automatically.

⑫ Adjust the laser intensity, sensitivity(HV),Gain and Offset. Press the and adjust not to saturate the image intensity.

**Acquiring the image**

⑬ Select [Normal] tab in [Acquire] Tool Window. Press the button to display the dialog box, and select the folder to save the images.

*The acquire images are saved automatically. Serial number is added at the end of file name like “***_0001” and “***_0002”.

⑭ Press button to start acquiring the image.

**Attention**

Check [LSM] in [Series] Tool Window whether it is selected “OFF” [Z] and [Time].
Lambda series
(acquiring by multiple channels)

*Before starting the following procedure, make adjustments for XY imaging. (refer to page 4-5.)

Changing to Lambda mode

Select one channel to be used
② Press the button. The [Dye & Detector Select] dialog box appears. Press the button to reset the Assigned Detector.
③ Select the [Channel] tab in [Dye & Detector Select] dialog box. Select the detector to be assigned to the observation channel in [Detector List], and press button. Press the button to close the [Dye & Detector Select] dialog box.
④ Tick the checkbox of the wavelength of the excitation laser to be used.

Setting DM and SDM
⑥ Select [LSMScanner] tab in [Lightpath] Tool Window. Press the DM button to display the dichroic mirror list. Select “DM” which reflects the wavelength of the excitation laser selected in ④.
⑦ Check the light path whether the light path is set properly.

Setting “Band width” and “Step Size”
⑧ In [PMT Setting] Tool Window, set the width of the wavelength for which the photometry is performed per each step in [Band width], and set the interval between the wavelength to start acquisition in the next step in [Step size]. (See page 26 “Standard” for details.)
Lambda series
(acquiring by multiple channels)

Setting the wavelength
⑨ Set them by dragging the mouse on the profile display area or set the value of wavelength directly to [CH1]. (★)

*You cannot select the laser which includes ±5nm of the excitation wavelength in the photometry range of each channel.

Adjusting the live image
⑩ Press the button to start scanning.
⑪ In ⑪ in left figure, enter the value of wavelength directly, to find the most efficient (brightest) range. Entering the value in the left box, changes the value in the right box based on Bandwidth automatically.
⑫ Adjust the laser intensity, sensitivity(HV),Gain and Offset. Press the and adjust not to saturate the image intensity.

Acquiring the image
⑬ Select [Normal] tab in [Acquire] Tool Window. Press the button to display the dialog box, and select the folder to save the images.
*The acquire images are saved automatically. Serial number is added at the end of file name like “***_0001” and “***_0002”.
⑭ Press button to start acquiring the image.
Processing: Unmixing (1)  
Spectral Image Unmixing  
~by specifying dyes

① Press the "Viewer" button to switch to “Viewer mode”.
③ Select [Single process] mode, press the [Post Processing] button.

④ Press the "Remove" button to reset the assigned item and select [Spectral Deconvolution] in [Processing Item].
⑤ In [Input] in [Input / Output setting], select the image for image processing.
⑥ In [Mode] in [processing Property], select “Spectral Image Unmixing”.

⑦ Specify multiple ROIs on the regions where only the target fluorescence dye locates to acquire the spectral data for image processing.
⑧ In [DYE0 ROI File Name], select the file name of the image on which the ROI was specified in ⑦.
⑨ In [DYE0 ROI Index], select the first ROI specified in ⑦.
⑩ Repeat ⑧⑨ to register all ROIs. Press the "Process" button to start the fluorescent separation process.

★ You can save Dye profile data which is specified by ROIs. (How to use this file? →See page 32⑦)
**Processing: Unmixing (2)\nBlind Unmixing\n~by setting the number of dyes~**

1. Press the **Viewer** button to switch to “Viewer mode”.
4. Press the **Remove** button to reset the assigned item and select [Spectral Deconvolution] in [Processing Item].
5. In [Input] in [Input / Output setting], select the image for image processing.
6. In [Mode] in [processing Property], select “Blind Unmixing”.
7. Set the number of dyes in [Number of Spectral Date].
8. Press the **Process** button to start the fluorescent separation process.
**Processing: Unmixing (3)  
Normal Unmixing  
~by specifying dye dates**

1. Press the **Viewer** button to switch to “Viewer mode”.
4. Press the **Remove** button to reset the assigned item and select [Spectral Deconvolution] in [Processing Item].
5. In [Input] in [Input / Output setting], select the image for image processing.
6. In [Mode] in [processing Property], select “Normal Unmixing”.
7. In “!DYE0 Dye Profile Load File”, select the first dye profile among from dye data. (See page 30.)
8. Select the all dye data.
9. Press the **Process** button to start the fluorescent separation process.
### オリンパス株式会社

<table>
<thead>
<tr>
<th>市・営業所所在地</th>
<th>郵便番号</th>
<th>電話番号</th>
</tr>
</thead>
<tbody>
<tr>
<td>東京</td>
<td>〒183-0014 東京都新宿区西新宿2-3-1 新宿モニトリス</td>
<td>☎️03 (6901) 4040</td>
</tr>
<tr>
<td>札幌</td>
<td>〒060-0034 札幌市中央区北四条東1-2-3 札幌フォコク生命ビル</td>
<td>☎️011 (222) 2553</td>
</tr>
<tr>
<td>静岡</td>
<td>〒420-0851 静岡市葵区美金町11-17 三井生命静岡駅前ビル</td>
<td>☎️054 (256) 6345</td>
</tr>
<tr>
<td>新潟</td>
<td>〒950-0877 新潟市中央区東大道14-11 日本生命新潟ビル</td>
<td>☎️025 (246) 7338</td>
</tr>
<tr>
<td>松本</td>
<td>〒390-0815 松本市篠志1-2-1 松本館ビル</td>
<td>☎️026 (355) 5432</td>
</tr>
<tr>
<td>金沢</td>
<td>〒920-0024 金沢市西区西1-1-3 コンフィデンス金沢</td>
<td>☎️076 (222) 3436</td>
</tr>
<tr>
<td>名古屋</td>
<td>〒460-0003 名古屋市中村区講2-2-2 名古屋丸ビル</td>
<td>☎️052 (201) 9686</td>
</tr>
<tr>
<td>名古屋</td>
<td>〒460-0003 名古屋市中村区講2-2-2 名古屋丸ビル</td>
<td>☎️052 (201) 9686</td>
</tr>
<tr>
<td>松山</td>
<td>〒790-0003 松山市三番町7-1-21 ローラル生命松山ビル</td>
<td>☎️089 (391) 2650</td>
</tr>
<tr>
<td>福岡</td>
<td>〒810-0004 福岡市中央区博多通1-3-6-11 福岡フォコク生命ビル</td>
<td>☎️092 (711) 1883</td>
</tr>
</tbody>
</table>

---

### お客様相談センター

**電話番号**: 0120-58-0414  FAX 03 (6901) 4251

受付時間 平日 8:45～17:30

---

<table>
<thead>
<tr>
<th>取扱販売店名</th>
<th>住 所</th>
<th>店 名</th>
<th>担当者</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>